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[bookmark: _Toc518640492][bookmark: _Toc10032430]Icon legends
	Icons
	Descriptions
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	Practice activity 
Learning activities are the tasks and exercises that assist you in gaining a clear understanding of the content in this workbook. It is important for you to undertake these activities, as they will enhance your learning.
Activities can be used to prepare you for assessments. Refer to the assessments before you commence so that you are aware which activities will assist you in completing your assessments.
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	Collaboration 
Whether you discuss your learning in an online forum or in a face-to-face environment discussions allow you to create and consolidate new meaningful knowledge.
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	Self-check
A self-check is an activity that allows you to assess your own learning progress. It is an opportunity to determine the levels of your learning and to identify areas for improvement.
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	Readings (Required and suggested)
The required reading is referred to throughout this Student workbook. You will need the required text for readings and activities. 
The suggested reading is quoted in the Student workbook, however you do not need a copy of this text to complete the learning. The suggested reading provides supplementary information that may assist you in completing the unit.


Students will need to copy files from their campus P drive onto their USB. Please ask your teacher for assistance and remember to remove the Read Only attribute when files are on your USB.


[bookmark: _Toc10032431]Introduction
This workbook will provide you with the skills and knowledge to design and create spreadsheets and charts while maintaining ergonomically safe work practices. You will learn about 
adjusting the workspace to meet WH&S requirements
identifying formatting and layout elements according to organisational requirements
entering data
using functions
creating formulae
using Help
creating charts
naming and storing spreadsheets.
There are many activities throughout, and your teacher will supply you with any computer files you need to complete them. 




Topic 1
Use relevant 
WHS practices


[bookmark: _Toc10032432]Topic 1: Use relevant WHS practices
Before learning more about how to use spreadsheets and working on a computer, you need to consider important safety practices. 
[bookmark: _Toc10032433]Guide to correct WHS practices
To make sure you are safe and healthy in the workplace, you need follow the relevant WHS practices.
Chair—height and back support 
Feet flat on floor.
Ankle, knees and hips at right angles.
Support lower back with back of the chair.
Back straight.
Table 
Adjust height of desk so elbows are at right angles to keyboard.
Tops of legs should be just below table.
Screen—tilt and brightness
Keep screen brightness to a minimum.
Tilt the screen so that you can view it comfortably.
Desktop layout 
Clear desk of all unnecessary materials.
Use a document holder for your working papers to avoid neck strain.
Power access 
To avoid personal injury, ensure all electrical leads and computer cables are out of the way.
Rest breaks and exercise periods 
Do some exercises or move away from the screen for five minutes every hour.
Stretch and relax fingers at least five times.
Blink eyes to rest and give them relief.
Lift shoulders upwards, backwards then relax them for one minute each.
Clasp hands above head, reach upwards, fingers interlaced, stretch, then drop arms.
[bookmark: _Toc10032434]Ways to reduce paper in a business environment
You can reduce the amount of paper you use at work if you:
Photocopy and print double sided.
Use waste paper as note pads.
Edit documents on screen.
Use a multi-function printer with options to print to mailbox or similar.
Switch to electronic communication.
Substitute paper communication with emails.
Use soft copy versions for filing.
Electronic invoicing and archiving.
Think before you print.
Request suppliers to print documents double-sided.
Specify recycled content paper in design briefs for professional communication materials.
Use recycled paper for office printing and photocopying.
Share newspapers and magazines or provide office copies so people don’t have to bring their own.
Print directly on to envelopes instead of using labels.
Provide staff with ‘internal mail’ envelopes that can be reused.
Introduce a printing policy that aims to minimise paper consumption.


	[image: ] Practice activity


[bookmark: _Toc9585534][bookmark: _Toc10032435]Activity: Set up the work area
[bookmark: _Toc9585535][bookmark: _Toc10032436]Check your neighbour’s work area
Before you get started, discuss your neighbour’s work area in relation to ergonomic and WHS requirements and complete the checklist below. Your neighbour will do the same for you!
Table 1: Ergonomic workplace check
	Ergonomic check
	

	1. They have adjusted the height of their desk and chair to suit their requirements.
	

	2. They have adjusted the height and angle of the monitor so that it is at eye level.
	

	3. Everything on the desk is within easy reach.
	

	4. They have access to a document holder.
	

	5. Their feet are flat on the floor, or they are using a footrest.
	


Table 2:  WHS check
	Work Health & Safety check
	

	1. They have set up the work area ergonomically to suit their requirements.
	

	2. All electrical cords are out of the way.
	

	3. There is adequate lighting and ventilation in the room.
	

	4. There are no trip hazards around their work area.
	

	5. They are aware they should take mini breaks to avoid muscle strain.
	






Table 3:  Energy check
	Energy & resource conservation check
	

	1. They are aware they should always proofread their work before printing.
	

	2. If possible, they should print double-sided.
	

	3. When they finish their work, they are aware they should “shut down” their computer.
	







Topic 2
Prepare to produce spreadsheets


[bookmark: _Toc10032437]Topic 2: Prepare to produce spreadsheets
In this topic, you will learn about the features of Excel spreadsheet so that you can create one in the next topic.
[bookmark: _Toc10032438]About spreadsheets
You can use spreadsheets for:
Budgeting at work.
Petty cash.
Reconciling bank statements.
Calculating payrolls.
Profit and loss calculations.
Personal budgeting.
Estimating costs.
Calculating loan repayments.
Record keeping for income tax.
[bookmark: _Toc10032439]Advantages 
Spreadsheets are very useful when working with data. For example:
Calculations—can be performed quickly and accurately.
Editing data—mistakes can be corrected before printing.
Recalculations—if a number is changed then any formula that depends on that number is recalculated almost immediately.
Storage—data can be easily stored on disk and retrieved when required.
[bookmark: _Toc10032440]Excel workbooks
A workbook is a file containing one or more sheets (worksheet). Each worksheet is a page in the workbook where you enter and work with data.
[image: ]
The position of the active cell in the spreadsheet is called its cell reference.
	If a cell is highlighted (selected), it is referred to as the active cell, and this is where the data can be entered or altered. The active cell’s address is shown at the left of the formula bar at the top of the screen.
The cell is the intersection of a row and a column.
There are three types of data which can be entered in a cell: 
Numbers—or values.
Text—alphanumeric characters which form labels or headings.
Formulas—instructions used by the spreadsheet to perform calculations. The answer to the calculation will always appear in the cell that contains the formula. The formula itself only shows on the formula bar at the top of the screen.
A formula always begins with an equal sign =, i.e.: =A4+D4.
Spreadsheet data consists of numbers, text and formulae.
[bookmark: _Toc10032441]Excel screen components 
[bookmark: _Toc10032442]The file tab
The File Tab holds the commonly used functions in all the Microsoft applications. The common functions of New, Open, Save, Print, Close, etc are located here.
[bookmark: _Toc10032443]Title bar 
Shows name of application, Microsoft Excel and name of workbook.


[bookmark: _Toc10032444]Quick access toolbar
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The Quick Access toolbar holds three buttons: Save, Undo and Redo. You can also add other buttons that you use often but we do not cover that at this level.
[bookmark: _Toc10032445]The ribbon 
The ribbon holds all the functions grouped together onto Tabs. Anything you want to do with your text can be carried out through these tabs. 
[bookmark: _Toc10032446]Home tab
The Home tab holds the commonly used functions for formatting cells and basic functions for working with data.
[image: ]
[bookmark: _Toc10032447]Insert tab
The Insert tab holds the buttons used to add pictures, charts, tables, etc to your spreadsheet.
[image: ]
[bookmark: _Toc10032448]Scroll bars 
Used to move up, down, left or right in worksheet.
[image: ]
[bookmark: _Toc10032449]Formula bar 
As you type data in an active cell, it also appears in the Formula bar. Also, the cell reference (A2) and the Enter  and Cancel  boxes are displayed.
[image: ]
[bookmark: _Toc10032450]Worksheet tabs 
A worksheet is selected by clicking once on a relevant tab. A workbook usually contains one worksheet but you can add as many as required. Useful for keeping related information together.
[image: ]
[bookmark: _Toc10032451]Minimise, Maximise and Close a workbook
When a window is active it shows three buttons at the top right hand corner.
[image: ]


[bookmark: _Toc10032452]The mouse pointer 
The shape of the mouse pointer varies. It is very important to learn to recognise the different shapes and their applications/uses.
Table 4: Mouse pointer shapes and meanings
	Symbol 
	Function 

	
	Located in the menu bar, scroll bars and chart window and used to point and select 

	
	Located inside a worksheet. Click to select a cell or range of cells.

	
	Located in the formula bar and text boxes, and within dialogue boxes.
Click to place an insertion point to start editing text, numbers or formula.

	
	Located along row headings. Drag to adjust the row height.

	
	Located along column headings. Drag to adjust column width.

	
	Auto Fill handle—when the mouse is positioned in the bottom right hand side of the active cell, formula or series can be copied by dragging down the Auto Fill handle.

	[image: ]
	Move handle – moves the contents of the cell(s).


[bookmark: _Toc10032453]Displaying and hiding ribbons 
If the ribbons are not remaining visible on the screen:
[image: ]
Right mouse click in Quick Access Toolbar area, then Select Collapse the Ribbon OR,
double click on the Home tab.
Use Manuals and On-Line Help (below image) to Solve Operational Problems.
[image: ]

[bookmark: _Toc10032454]Help feature 
To open Help on your screen, press F1.
[image: ]
You can then type in the search box the topic you need help with.
Type in your question using plain English, then click on Search. 
	[image: ]
	Practice activity


[bookmark: _Toc518632731][bookmark: _Toc10032455]Activity: Formulas
Type in your questions in the box provided: 
Type in formula—click on Search—double click Overview of formulas in Excel.
Type in format—click on Search—double click on Create or delete a custom number format.
The Tell Me button edits your spreadsheet automatically to reflect what you ask.
For example, click on a cell and then click on Tell Me and type centre and the text in the cell is automatically entered.
To insert a row, click on the row you want to move down and click on Tell Me and type insert row and the row is automatically inserted.


[bookmark: _Toc10032456]Microsoft excel—simple formulas
Table 5: Excel quick reference formulas
	Total
	∑
	Autosum – adds a list of numbers to the left or above 

	Addition 
	=SUM(B2:B10)
=B2+B10
	Adds ALL the cells from B2 to B10.
Adds contents of B2 to contents of B10.

	Subtraction 
	=B10-B2 
	Subtracts cell B2 from cell B10.

	Multiplication 
	=B2*B10 
	Multiplies cell B2 by cell B10.

	Division 
	=B2/B10
	Divides cell B2 by cell B10.

	Average 
	=AVERAGE(B2:B10)
	Finds the average of cells B2 to B10.

	Maximum 
	=MAX(B2:B10)
	Finds the highest value in cells B2 to B10.

	Minimum 
	=MIN(B2:B10)
	Finds the lowest value in cells B2 to B10.

	Count 
Numbers 
	=COUNT(B2:B10) 
	Counts the number of values in cells B2 to B10.

	Percentage 
	=B2*10% 
=B2+B2*10% 
=B2-B2*10% 
	Finds 10% of the value in cell B2.
Finds the new value including 10% markup.
Finds the new value deducting 10% markdown.

	Today 
	=TODAY() 
	This shows the system date.

	Turn Formulas on/off 
	CTRL ~ 
	This displays the formulas in your worksheet, press again to return to your data.




Example showing discount and discounted price
Table 6: Example of discounted price formula
	
	A 
	B 
	C 
	D 
	E

	1 
	Item 
	Price 
	Discount % 
	Amount of Discount 
	Discounted Price 

	2 
	
	
	
	
	

	3 
	Dress 
	$60.00
	10%
	=B3*C3
	=B3-(B3*C3)

	4 
	Jacket 
	$120.00
	10%
	=B4*C4
	=B4-(B4*C4)


Answers below: 
Table 7: Numbers for discounted price
	
	A 
	B 
	C 
	D 
	E

	1 
	Item 
	Price 
	Discount % 
	Amount of Discount 
	Discounted Price 

	2 
	
	
	
	
	

	3 
	Dress 
	$60.00
	10%
	=$6.00 
	=$54.00 

	4 
	Jacket 
	$120.00
	10%
	=$12.00 
	=$108.00 


Example showing GST and increased price
Table 8: Example of GST added to price
	
	A 
	B 
	C 
	D 
	E

	1 
	Item 
	Price 
	GST % 
	Amount of GST 
	New Price

	2 
	
	
	
	
	

	3 
	Pants 
	$50.00
	10%
	=B3*C3 
	=B3+(B3*C3) 

	4 
	Skirt 
	$80.00
	10%
	=B4*C4 
	=B4+(B4*C4) 




Answers below:
Table 9: Numbers for GST added to price
	
	A 
	B 
	C 
	D 
	E

	1 
	Item 
	Price 
	GST % 
	Amount of GST 
	New Price

	2 
	
	
	
	
	

	3 
	Pants 
	$50.00
	10%
	=$5.00 
	=$55.00 

	4 
	Skirt 
	$80.00
	10%
	=$8.00 
	=$88.00 


[bookmark: _Toc10032457]Data series 
A data series is a series of values that you need in a worksheet, where the individual values are related to each other in a simple way e.g. series of dates, days, years, numbers.
[bookmark: _Toc10032458]Procedure
Key in first of series e.g. Monday, January etc. 
Drag fill handle (Autofill) down or across the cells where series is to be copied to and release.
[image: ]
Note: This same method applies to dates, days, numbers etc. Just highlight enough cells to set the format.
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	Practice activity


[bookmark: _Toc10032459]Activity: Series
Open the workbook: SERIES. Use autofill to create a series for each column:
A series of months—key in first month, use autofill and drag down or across.
A series of numbers— 1,2,3 etc. Type 1—hold down <CTRL> when using autofill.
A series of time of day and days of the week— as for months.
A series of numbers that are not consecutive (must key in first 2 numbers as example).


Topic 3
Create simple 
spreadsheets


[bookmark: _Toc10032460]Topic 3: Create simple spreadsheets
[bookmark: _Toc10032461]Creating a worksheet
[bookmark: _Toc10032462]Enter data into a worksheet
An entry made into a cell is either a label, number or formula. Text is called a label, headings are a common form of label entry and can be comprised of letters and/or numbers. Text is automatically left aligned and numbers (also called values) are automatically right aligned. 
Click on the cell where data is to appear.
Type in the data.
Confirm the data entry by pressing [ENTER] or any of the cursor movement keys.
[bookmark: _Toc10032463]Correcting mistakes 
If you make a mistake while you are entering data you can: 
press the <BACKSPACE> key then retype the data.
Stop the entry by clicking the x button in the Formula Bar.
Press the <ESC> key.
If you have already accepted the cell entry: 
click on the cell and retype the whole entry, OR 
press <F2> and edit within the cell.


	[image: ]
	Practice activity


[bookmark: _Toc10032464]Activity: Create a worksheet 
Click on the File Tab and select New, Blank Workbook. Create and enter the data below: 
Note: the text appears left aligned and the numbers right aligned.
Table 10: Activity task example
	
	A
	B
	C
	D
	E
	F

	1
	BUS ROUTE
	AUG
	SEPT
	OCT
	NOV
	DEC

	2
	University-Belmont
	2430
	1544
	1128
	3055
	1245

	3
	Newcastle-Wallsend
	1215
	1602
	1724
	2411
	2602

	4
	Charlestown-Newcastle
	1844
	1745
	2350
	1985
	2187

	5
	Newcastle-Swansea
	2343
	1677
	1695
	2245
	2946


Save your new worksheet.
Click on the File Tab, Save As, and save to your USB Drive (you may need to Browse to find it).
File Name Type BUSFARE over Book1, and click on Save.
Close the worksheet—click on the cross in the top right corner of worksheet 
Your teacher will also show you how to save using the Quick Access Toolbar.
[bookmark: _Toc10032465]Save your worksheet to the cloud
[image: ]
Cloud storage example
You can Save your worksheet to the Cloud.
Click on the File Tab, Save As.
Next, Save your document to a OneDrive location (or any version of cloud storage)–as shown above (Save to Cloud).
[bookmark: _Toc10032466]Share your worksheet with others
[image: ]
You can share your worksheet with others so that they can also access the document. Click on the File Tab, Share.
Step 1: Save your document to a OneDrive location (Save to Cloud).
Step 2: Share your document (you can share on the Cloud as shown below or attach as a copy).
[image: ]
	[image: ]
	Practice activity


[bookmark: _Toc10032467]Activity: Resaving
Click on the new workbook button on the Quick Access Toolbar and save with the filename: FLOORSPACE.
Enter the following data: 
Table 11: Data to be entered - Floorspace
	
	A
	B
	C
	D
	E

	1
	CENTRE
	SHOP 1
	SHOP 2
	SHOP 3
	SHOP 4

	2
	Westfield
	245
	288
	386
	550

	3
	Stockland
	408
	1020
	598
	460

	4
	Victoria Square
	550
	459
	644
	780

	5
	Miranda Fair
	424
	1228
	708
	850


Resave workbook—Click on the Save icon. Close the FLOORSPACE workbook.
Create a new workbook and save with the filename: KMRATE.
Enter the following data: 
Table 12: Date to be entered - KMRATE
	
	A
	B
	C
	D
	E

	1
	SALES REP
	WEEK 1
	WEEK 2
	WEEK 3
	WEEK 4

	2
	Smith Don
	550
	624
	216
	308

	3
	Bennett Paul
	300
	221
	295
	180

	4
	Denver Carl
	412
	210
	197
	215

	5
	Adams John
	511
	189
	201
	324


Resave workbook—Click on the Save icon. Close the KMRATE workbook.
Create a new workbook and save with the filename: HOLIDAY.


Enter the following data: 
Table 13: Data to be entered – Holiday
	
	A
	B
	C
	D

	1
	DESTINATION
	JAN
	FEB
	MAR

	2
	Barrier Reef
	210
	405
	311

	3
	Fiji
	425
	372
	555

	4
	Hawaii
	505
	598
	432

	5
	Caribbean
	366
	393
	210

	6
	Norfolk Island
	260
	84
	56


Resave workbook—Click on the Save icon. Close the Holidays workbook.
[bookmark: _Toc10032468]Open, edit/change and resave a workbook 
Open a workbook (busfare) 
Click on the File Tab and select open—recently used files are displayed under the Recent option, otherwise use Browse to make sure you are in drive ‘d’ (USB).
Select/highlight the filename BUSFARE.
Click on Open OR double click on the filename.
Edit/change data 
Move cursor to C5. 
Type in 1566 and press <ENTER> or use arrow key.
Move to F2, change to 2244 and press <ENTER>.
Your workbook should now look like this:
Table 14: Bus route activity example
	
	A
	B
	C
	D
	E
	F

	1
	BUS ROUTE
	AUG
	SEPT
	OCT
	NOV
	DEC

	2
	University-Belmont
	2430
	1544
	1128
	3055
	2244

	3
	Newcastle-Wallsend
	1215
	1602
	1724
	2411
	2602

	4
	Charlestown-Newcastle
	1844
	1745
	2350
	1985
	2187

	5
	Newcastle-Swansea
	2343
	1566
	1695
	2245
	2946


Resave workbook—Click on the Save icon, on the Quick Access toolbar. 
Close the BUSFARE workbook.

	[image: ]
	Practice activity


[bookmark: _Toc10032469]Activity: Editing data
Open the workbook FLOORSPACE.
Edit/change data 
Move cursor to C4 and change to 785.
Move cursor to E3 and change to 640.
Resave and close the workbook.
Open the workbook: KMRATE.
Edit/change data 
Move cursor to B5 and change to 155.
Move cursor to D2 and change to 314.
Resave and close the workbook.
Open the workbook: HOLIDAY.
Edit/change data 
Move cursor to B6 and change to 78.
Move cursor to C3 and change to 480.
Resave and close the workbook.
[bookmark: _Toc10032470]Change column width 
Position cursor on vertical line between column letters (pointer changes to black cross with arrows on horizontal bar).
Click and drag to required width.
Repeat for all columns where required.
[bookmark: _Toc10032471]Align and enhance data 
Select/highlight all column headings.
Click on left, centre or right align icon on toolbar.
Select/highlight data then click to bold, italicise or underline.

	[image: ]
	Practice activity


[bookmark: _Toc10032472]Activity: Columns
Open: BUSFARE 
Format
Widen the first column.
Right align headings for columns B-F.
Bold all column headings.
Edit
University-Belmont figures for October are 1326—change figure accordingly.
September figures for Newcastle-Swansea should be 1524.
Resave and close the workbook.
Open: FLOORSPACE
Format
Widen the first column.
Place centre names in italics, and right align and bold headings for columns B-E.
Change Victoria Square to Chatswood Chase.
Resave and close the workbook.
Open: KMRATE 
Format and Edit
Widen any columns if required.
Right align column headings where appropriate.
Column headings to be in bold and italics.
Paul Bennett’s mileage for week 2 should be 285.
Carl Denver’s first name is Chris, not Carl.
Resave and close the workbook.
Open: HOLIDAY 
Format and Edit 
Widen the first column and make other columns smaller.
All destinations to be in italics and right aligned.
Column labels (headings) to be bolded.
Right align ALL column headings.
Change figures for Norfolk Island to 98, 74 and 62 respectively.
Resave and close the workbook.
[bookmark: _Toc10032473]Insert rows and centre heading over worksheet
Insert a row 
A new row will always be inserted above the active cell so ensure you have it placed correctly.
From the Home ribbon select the insert button and then Insert Sheet Rows OR right click and select Insert.
Enter new data.
Centre the heading over the worksheet 
Select/highlight the cells containing the heading, drag mouse along the row to the last column that contains data.
Click on the MERGE and CENTRE button on the Home ribbon.
[image: ]
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	Practice activity


[bookmark: _Toc10032474]Activity: Adding content
Open: BUSFARE 
Add a blank row at the top of the worksheet 
Insert a main heading in first column—SALES FOR HALF-YEAR—place in bold and italics.
Centre the main heading over the columns.
Insert a new row above Charlestown-Newcastle and enter the following data: 
Shortland-Newcastle—1505, 1640, 1668, 2535, 2602 
Resave and close the workbook.
Open: FLOORSPACE 
Add two new rows at the top of the worksheet.
Insert a main heading in top row—SHOP FLOOR SPACE AVAILABLE—place in bold.
Insert a subheading in second row—Measurements given in metres—in italics.
Centre both the headings over the columns. Hint: do one row at a time.
Insert a blank row above Stockland and enter the following data; 
Maroubra Junction—322, 402, 266, 410.
Resave and close the workbook.
Open: KMRATE 
Insert a blank row to separate column headings from column text.
Insert two blank rows at top of worksheet.
Enter a main heading—KILOMETRES TRAVELLED—bold and centre heading over columns.
Resave and close the workbook.


Open: HOLIDAY 
Insert a row above Hawaii.
Enter the following data: Solomon Islands – 29, 14, 35.
Insert a new row at beginning of worksheet.
Enter a main heading—holiday destinations—in bold and centre heading over columns.
Widen first column if required.
Resave and close the workbook.
[bookmark: _Toc10032475]Insert a column
A new column will always be inserted to the left of the active cell so ensure you have it placed correctly.
From the Home ribbon select the insert button and then Insert Sheet Columns OR right click and select Insert.
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	Practice activity


[bookmark: _Toc10032476]Activity: New columns
Open: BUSFARE 
Insert a new column at column B headed BUS NUMBER.
Insert the following numbers into this column: Charlestown/Ncle—N228, Ncle/Swansea—N350, Ncle/Wallsend—N232, Shortland/Ncle—N108, 
Uni/Belmont—N336.
Bus numbers are to be centred, along with the column heading.
Add a heading TOTAL in column H.  Format the heading so it is consistent with other column headings.
Resave and close the workbook.


Open: FLOORSPACE 
Insert a new column at column B headed OCCUPANCY RATE, widen the column if necessary.
Insert the following numbers into this column: 0.75, 0.8, 0.95, 0.85, 0.7. Centre figures in column. Figures are NOT to be italicised.
Insert a new heading TOTAL after last column. Ensure it is formatted consistently.
Resave and close the workbook.
Open: KMRATE 
Insert a new column at column A headed DEPARTMENT—re-centre main heading.
Widen column and format heading so it is consistent with other column headings.
Insert the following data into the new column—Haberdashery, Menswear, Toys, Kitchenware.
Resave and close the workbook.
Open: HOLIDAY 
Insert a new column at column B headed TOUR CODE, widen column if necessary.
Insert the following tour codes into this column: BAR122, FIJ205, SOL196, HAW015, CAR158, NOR010. Codes are not to be italicised 
Insert new column at end headed TOTAL. Format heading so it is consistent with others.
Re-centre main heading.
Resave and close the workbook.


[bookmark: _Toc10032477]Sort a worksheet
Position cursor in any cell in the column that you want to be sorted.
Do not highlight data.
On the Home Ribbon click on Sort and Filter and select either Sort A to Z for ascending order, or
Z to A for descending order.
[image: ]
Hint: Excel can recognise column headings but it is best to insert a blank row between data and total rows before sorting.
You can also highlight ALL the rows to select the entire worksheet then click on Custom Sort to specify and control how your worksheet is sorted.
[bookmark: _Toc10032478]Apply a border, background colour and font colour
Select range:
click on ▼ next to Border tool and choose style of border.
click on ▼ next to Fill Colour tool and choose a colour.
click on ▼ next to Font Colour tool and choose a colour for your text.
Table 15: Border and font colour tools
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	Border Tool
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	Shading Tool

	[image: ]
	Font Colour Tool
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	Font Size




[bookmark: _Toc10032479]Alignment 
Wrap text in cell 
Text can be wrapped around a cell using the following button on the Home ribbon:
[image: ]
Text alignment 
Text is generally vertically aligned within a cell and can be changed using these buttons on the Home ribbon.
[image: ]
[bookmark: _Toc10032480]Increase row height
Procedure (read only).
Highlight row/s in worksheet – black arrow on actual number (grey area)—drag down.
Position pointer on horizontal line between any two numbers.
Click and drag down until reference area displays required height and release mouse button
OR, Right click on row number, choose Row Height, type in desired number for row height.
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	Practice activity


[bookmark: _Toc10032481]Activity: Sorting
Open: BUSFARE 
Sort into alphabetical order by bus route (see previous page).
Main heading to be in large font size, e.g. 16 and italicise names of bus routes.
Insert a blank row to separate main heading from table.
Enhance the main heading with a border, fill colour and font colour.
Re-centre main heading over columns—wrap text in column headings and vertically centre.
Decrease column width of BUS NUMBER to make text wrap—increase row height if necessary.
Insert a new heading TOTAL (in bold) in cell A10.
Resave and close the workbook.
Open: FLOORSPACE
Separate main headings from column headings by inserting a blank row.
Main heading to be in large font size, fill colour and font colour.
Column headings to be in bold and one font size smaller.
Wrap column headings and re-centre main and sub-headings across columns—adjust column widths if necessary.
Sort the worksheet in reverse order by shopping centre.
Resave and close the workbook.
Open: KMRATE 
Add new heading TOTAL at column G and in cell A10.
Headings to be in bold • Sort table by sales rep.
Re-centre main heading across columns and format to larger font size.
Insert borders, fill colour and font colour where appropriate.
Resave and close the workbook.
Open: HOLIDAY 
Insert a row above and below column headings.
Increase font size of main heading and re-centre across columns.
Sort into descending order by tour code.
Resave and close the workbook.


[bookmark: _Toc10032482]Create a header and footer 
Procedure (read only)
Select the Insert ribbon.
Click on HEADER/FOOTER.
Header area will be split into three sections; left, middle and right.
Make your selection from the header and footer elements below or simply enter a choice of your own.
To add a footer, click on “Go to footer”.
To return to your spreadsheet click anywhere in the worksheet area. You will still be in Page.
Layout View. Go to View Ribbon, choose Normal View or click on the grid button on bottom right of screen.
[image: ]
[bookmark: _Toc10032483]Remove border and colour
Remove border—select cells—choose No border from Border tool (5th icon in drop down box).
Remove colour—select cells—choose Automatic from Colour Font tool.
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	Practice activity


[bookmark: _Toc10032484]Activity: Heights
Open: BUSFARE 
Click on the row numbers and increase row height to 22.5.
Insert a header—your name and the current date and insert a footer – the workbook filename.
Remove border and fill colour from the worksheet.
Resave and close the workbook.
Open: FLOORSPACE 
Click on the row numbers and increase row height to 19.00.
Insert a header—the workbook filename and a footer—your name.
Resave and close the workbook.
Open: KMRATE 
Click on the row numbers and increase row height to 17.75.
Insert a footer—your name, the current date and the workbook filename.
Resave and close the workbook.
Open: HOLIDAY 
Click on the row numbers and increase row height to 21.00.
Insert a header—your name and the current date.
Insert a footer—the workbook filename.
Resave and close the workbook.
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	Practice activity


[bookmark: _Toc10032485]Activity: Revision exercise
Open: OUTGEAR 
Apply colour and borders, wrap column headings, bold and vertically align in cell.
Increase row height to 22.5 for all rows containing data.
Centre heading and sub-heading across worksheet, bold and increase point size to 18.
Insert a header (filename) and a footer (your name).
Save and close.
[bookmark: _Toc10032486]Autosum
Procedure (read only)
The ∑ symbol on the Home ribbon will add either vertically or horizontally. Use Autosum for adding figures.
Position cursor in cell where total is to be inserted.
Click on ∑. Area to be added is surrounded by a moving line (check the area is correct).
Click on ∑ again to insert total figure.
[bookmark: _Toc10032487]Copying formula using autofill
Position cursor in cell that contains the formula to be copied.
Move mouse pointer to bottom right hand corner of box (called the fill handle).
You will know you are in the correct position when pointer changes to a thinner black cross + 
Drag fill handle down or across the cells where formula is to be copied to and release.


[bookmark: _Toc10032488]Format to currency
Highlight column to be formatted.
Click on the drop down arrow next to General in the Number Format group (located on the Home Ribbon).
Select currency to have 2 decimal places and $ positioned next to numbers or select Accounting to have 2 decimal places and $ spaced away from numbers.
	[image: ]
	Practice activity


[bookmark: _Toc10032489]Activity: Autosum
Open: BUSFARE
Use AUTOSUM to add the TOTAL column—calculate horizontal totals.
Copy formula down.
Insert formula at foot of August column to calculate totals for AUGUST. Copy formula across remaining columns.
Format all figures to currency (except BUS NUMBER) with the dollar sign next to numbers.
Insert top and bottom border around column headings and also around TOTAL row. Add fill colour to column headings.
Preview using Print Preview button.
Resave and close.
Open: FLOORSPACE
Use AUTOSUM to add the TOTAL column and copy formula down.
Insert top and bottom border around column headings and add fill colour.
Use another fill colour to highlight to Occupancy Rate column.
Click on the percentage button on the toolbar to format those cells to a percentage.
Resave and close.


Open: KMRATE
Use AUTOSUM to calculate horizontal and vertical totals.
Sort into alphabetical order by Department.
Resave and close.
[bookmark: _Toc10032490]Workbooks
A workbook consists of a set of related worksheets. Related data can be kept in one location. You can move around the workbook using the navigation buttons or clicking on the sheet tab.
[image: ]
To add a sheet within the same workbook
Click on the New sheet button.
To move a sheet within the same workbook
Select sheet tab you wish to move.
Drag it to its new location (note triangle indicates position).
Release mouse button when triangle is in desired location.
Delete a sheet 
With mouse positioned over sheet tab to be deleted, click right mouse button.
Select Delete from the dialogue box.
Rename a sheet 
With mouse positioned over sheet tab to be renamed, double click left mouse button.
Existing name will be highlighted.
Type the new name then press Enter.
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	Practice activity


[bookmark: _Toc10032491]Activity: Totals
OPEN: the workbook TOTALS
Click on worksheet tab COLES in bottom left-hand corner of screen to open.
[image: ]
Total the month of January using (Autosum) in the editing section of the home ribbon.
Use Autofill to copy formula for all months.
Total the columns GROCERIES, MEATS, SUNDRIES and MONTHLY TOTAL.
Format to currency and apply borders, colour and/or pattern where appropriate.
Centre the heading and sub-heading across the worksheet.
Bold and increase point size to 16.
All column headings should be vertically centred—MONTHLY TOTAL should be wrapped in cell.
Click on the MUSIC tab (TOTALS workbook).
Calculate the TOTAL SALES and ITEM TOTALS.
Change the sales of ALBUMS for JUL-SEPT—it should be 55500.
Insert a new column after SINGLES for COMPACT DISKS and enter the figures below: 
	JAN-MAR 	40348
	APR-JUN 	53098
JUL-SEPT 	43521
OCT-DEC 	64890
Auto-fill formulae across where necessary—check the TOTAL SALES to ensure range is correct.
Apply right alignment, word-wrap and vertical centring to ALL column headings.
Apply italics and bold where desired and currency where appropriate.
Apply borders and colour and Increase row height to all cells containing data to 22.5.
Click on the MARKS tab (TOTALS workbook).
Calculate the total marks for each subject.
Change the row labels to italics and increase the row height to 22.
Bold, vertically centre and word-wrap column headings - apply borders appropriately.
Insert a new student ARNOLD—His marks are: Spreadsheet Fundamentals (66), Database Fundamentals (79), Data Retrieval (89), and Computer Operations (55).
Insert a suitable title at the top of the worksheet, centred across worksheet and insert a blank row under the title.
Save and Close workbook TOTALS.
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	Practice activity


[bookmark: _Toc10032492]Activity: Calculate
Create the new workbook as shown below and save as PAPER.
Table 16: Paper task
	
	A
	B
	C
	D
	E

	1
	PAPER DISTRIBUTORS LTD
	SALES FIGURES
	
	
	

	2
	
	
	
	
	

	3
	AREA
	SEPT
	OCT
	NOV
	TOTAL

	4
	CITY
	6892
	6412
	6011
	

	5
	LAKE MACQUARIE
	5831
	4998
	3532
	

	6
	UPPER HUNTER
	2698
	2846
	2561
	

	7
	CENTRAL COAST
	4325
	4871
	3996
	

	8
	MANNING
	1675
	2023
	2174
	

	9
	
	
	
	TOTAL SALES
	


Ensure fields display all data. Use bold and italics where appropriate. Insert a border or fill colour to the main heading and centre over worksheet.
Calculate the total cost of each area (TOTAL) and auto-fill/copy down.
Calculate the TOTAL SALES.
A mistake was made when compiling data—Lake Macquarie for November should be 6032.
December figures have now been completed—Insert a column DEC and enter the following data: 
	City 			(7556)
Lake Macquarie 	(5999)
Upper Hunter 		(3012)
	Central Coast 		(5050)
Manning 		(3074)
Note: UPDATE TOTAL—click on AutoSum again and fill down to include new data.
Insert a row between Lake Macquarie and Upper Hunter called PORT STEPHENS and insert the following:
	Sept 	(1568)
Oct 	(1998)
Nov 	(2020)
Dec 	(4567).
Note: Update TOTAL (use Autofill/fill handle).
Delete a row—Central Coast has been included in the Sydney area.
On the Home Ribbon, go to the Number area and format appropriate columns to currency.
Decrease the decimal places to zero i.e. no decimal places—select cells, click on decrease button on the Home Ribbon.
Insert blank row between data and TOTAL SALES.
Sort the spreadsheet in ascending order according to AREA (DO NOT HIGHLIGHT DATA).
Resave and print the worksheet with the filename and your name in the footer.
[bookmark: _Toc10032493]Functions
A function is a pre-written or in-built formula. All functions, like formulae, begin with an equal sign (=). Functions also include an argument plus a range in brackets after the function name.
The range has a colon (:) between the first and last cell, e.g. =SUM(A1:A3) 
Active cell is where the result of the calculation is to appear.
Key in equal sign and function name, plus range in brackets <ENTER>.
Position cursor in cell that contains function to be copied.
Position cursor in bottom right hand corner of cell (thin black cross).
Drag down or across range.
Example: =SUM(A5:A10).
Adds the values in the range starting with A5 and ending with A10.
The functions you will cover in this unit are:
	SUM
	=SUM(A5:A10)
	Example as above (usually inserted using the autosum button).

	AVERAGE
	=AVERAGE(A5:A10)
	Adds the values in the range, divides the total by number of values.

	MINIMUM
	=MIN(A5:A10)
	Inserts the minimum/lowest value in the stipulated range

	MAXIMUM
	=MAX(A5:A10)
	Inserts the maximum/largest value in the stipulated range


Some functions can be set up automatically from the arrow next to the Autosum icon—the function name will be inserted and you then need to select the range of cells you wish to use for the function selected.
[image: ]
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	Practice activity


[bookmark: _Toc10032494]Activity: Functions
Open: the workbook FUNCTIONS
Click on SUPERMARKET tab.
Key in January then use Autofill to enter remaining months to December.
Calculate totals.
Format to currency using Home Ribbon—Number, (Format cells dialog box appears, Number choose Currency, 2 Decimal Places ($ sign is placed next to number).
Insert a new row label AVERAGE underneath TOTAL and calculate average for Groceries, Meats and Sundries (do NOT include TOTAL figures when averaging).
Insert a new column label next to MONTHLY TOTAL called AVERAGE and calculate average for each month (do NOT include TOTAL figures when averaging).
Meats for AUGUST have been entered incorrectly, they should be: 19,700. Please amend.
Increase row height for data January to December to 19.50.
Double click on the SUPERMARKET tab. Change worksheet name to GREENS.
Click on MUSIC BOWL tab (FUNCTIONS workbook).
Format to currency using $ on Ribbon ($ spaced away from numbers).
Click on decrease decimal button to format to 0 decimal places.
Insert a new row label AVERAGE underneath YEARLY TOTALS and calculate average for each item.
Insert a new column label AVERAGE SALES next to TOTAL SALES and calculate average for each quarter and yearly total.
Wrap text and vertically centre in cell where appropriate. Apply bold, italics, colour, patterns and borders where appropriate.
Click on COMPUTING tab (FUNCTIONS workbook).
Insert a new row label AVERAGE under TOTAL and calculate the average marks for each module.
Insert a new column label AVERAGE next to TOTAL and calculate the average marks for each student 
Increase the point size to 16 for the main heading 
Insert a new row label MAXIMUM underneath AVERAGE and determine the highest mark for each module.
Insert a new row label MINIMUM underneath MAXIMUM and determine the lowest mark for each module.
Click on CLASS tab (FUNCTIONS workbook).
Calculate horizontal and vertical totals.
Widen columns so they look less crowded.
Headings should be in bold and aligned with their respective column data.
Sort into ascending alphabetical order by student.
Add a new column (in Column G) headed AVERAGE. Calculate average mark for each student.
Add a new row at the end (in A10) headed AVERAGE. Calculate average for each subject.
Insert your name in a footer and the filename and date in the header and resave.
[bookmark: _Toc10032495]Calculations and formula – mathematical operators
Excel is used mainly to do mathematical calculations. The computer symbol for each of the operators is shown in the table below:
Table 17: Mathematical operations symbols
	
	Mathematical Operators

	^
	Exponention eg 5^2 means 5 * 5 which is 25 

	*
	Multiplication 

	/
	Division 

	+
	Addition 

	-
	Subtraction 




[bookmark: _Toc10032496]Order of operations 
It is possible to get two different results for a simple calculation like 3 + 2 * 4 depending on the order in which the operations are carried out. If the operations are done in strictly left to right order the result is 20. If a priority is assigned to multiplication over addition then the answer is 11. To maintain consistent results, the operations are done according to a set of priority rules as outlined in the following table.
Table 18: Priority table
	
	Mathematical Operators Priority Rules

	( )
	Operations enclosed in parentheses are done first 

	^
	Exponentions are done next from left to right 

	* and /
	Multiplication and division are done next from left to right 

	+ and -
	Additions and subtractions are done next from left to right 


[bookmark: _Toc10032497]Entering a formula 
To enter a formula in an active cell, first press = (equal sign) to signify that what follows is a formula. Using the keys on the numeric keypad will make formula entries easier.
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	Practice activity


[bookmark: _Toc10032498]Activity: Data
Table 19: Activity data
	
	
	Result

	1
	=4+2*5 
	14 

	2
	=(4+2)*5 
	30 

	3
	=2*4+32/4-3 
	13 

	4
	=2*(4+32)/4-3 
	15 

	5
	=2*4+32/(4-3) 
	40 

	6
	=2*(4+32)/(4-3) 
	72 

	7
	=(2*4+32)/4-3 
	7

	8
	=(2*4+32)/(4-3) 
	40 


Create: a workbook and save as MATHS 
Sheet 1 will be created and named Waratah.
Calculate TOTAL for Quantity only.
Calculate TOTAL PRICE—insert formulae as indicated in D4 and Auto-fill down.
Format to currency where appropriate.
Table 20: Total price data
	
	A
	B
	C
	D

	1
	Waratah Nursery
	
	
	

	2
	
	
	
	

	3
	Type of Plant
	Price
	Quantity
	Total Price

	4
	Protea
	7.55
	20
	=b4*c4

	5
	Banksia
	6.95
	15
	

	6
	Wattle
	3.50
	30
	

	7
	TOTAL
	
	
	


Result? 		QUANTITY 65 
TOTAL PRICE		Protea $151.00	Banksia $104.25	Wattle $105.00
Click into Sheet 2 and enter the following information:
Name this sheet Profit then calculate the profit/loss:
Table 21: Profit data
	
	A
	B
	C

	1
	Waratah Nursery
	
	

	2
	
	
	

	3
	
	Plants/Seedlings
	Pots/Ponds

	4
	Income
	3500.00
	6034.00

	5
	Expenditure
	2568.00
	3976.50

	6
	Profit/Loss
	=b3-b4
	=c3-c4


Result?		Plants/Seedlings $932.00		Profit:
Pots/Ponds $2057.50			Profit:

Of course, the AVERAGE function is easier.
Table 22: Average function
	
	A
	B
	C
	D
	E

	1
	STUDENT
	S/SHEET
	D/BASE
	COMPUTING
	AVERAGE MARK

	2
	
	
	
	
	

	3
	Julie
	67
	84
	74
	=AVERAGE(B3:D3)

	4
	Kelly
	76
	67
	88
	Fill down formula

	5
	Megan
	91
	85
	82
	Fill down formula


Result?	Averages for: Julie (75), Kelly (77), Megan (86)
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	Practice activity


[bookmark: _Toc10032499]Activity: Tabs
Open the workbook OPERATOR 
Click on each separate Tab to open worksheets.
DUFFY 
Format the worksheet—use bold, italics, borders, shading, currency and wrap text where appropriate.
Centre the heading over worksheet—point size 18.
Calculate the Gross Wages (Hours per week x Rate per Hour).
Calculate the Total Wages and wrap the text TOTAL WAGES in box.
B Dander only worked 38 hours—update entry—note recalculation.
XMAS 
Format appropriately and calculate totals for QUANTITY and TOTAL COST columns.
AEROBIC 
Format the spreadsheet.
All columns except Column A should be centred and column headings should be wrapped in cell and vertically aligned—all columns should be wide enough to display all data.
Amounts of money should be displayed in currency with two decimal places.
All row labels should be in italics and all column headings should be in bold.
Calculate the SESSION INCOME (Number of Students x Cost per Student).
Total the NUMBER OF STUDENTS and the SESSION INCOME.
Insert a new row label AVERAGE underneath TOTAL and calculate the average Number of Students, Cost per Student and Session Income.
Insert a new row label (wrapped and vertically centred in cell) MINIMUM NUMBER and calculate the minimum number of students.
Insert a new row label underneath MINIMUM NUMBER called MAXIMUM NUMBER and calculate the maximum number of students.
Sort the spreadsheet in ascending order according to CLASS.
Insert your name and the date in the Header and the filename in the Footer.
PAYROLL (OPERATOR workbook)
Headings to be in bold and italics and aligned with their respective column text.
Calculate gross pay (Hours Worked * Hourly Rate)—copy the formula down the column.
Calculate net pay (Gross Pay—Deductions)—copy the formula down the column.
Place the heading TOTALS below the employees’ names. Calculate vertical totals for Gross Pay, Deductions and Net Pay.
Format all money columns to currency, two decimal places.
Sort into descending alphabetical order by name.
Pauline worked 38 hours and Phil worked 35. Change their figures accordingly—check that their payroll figures recalculate.
Place your name in the footer and the filename in the header.
STATION (OPERATOR workbook)
Calculate the gross profit (Sales—Cost of Sales) and copy formula down
Calculate net profit (Gross Profit—Expenses) and copy down
Calculate the TOTALS row at bottom of worksheet
Sort the worksheet in descending alphabetical order by OUTLET. Insert a blank row to separate main heading from column headings. 
Right align those headings which sit above figure columns. Place all column and row headings into italics and Times Roman font in a suitable size.
Format all figure columns as currency columns.
Place your name in the footer and the filename in the header.
Resave and close the operator workbook.
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	Practice activity


[bookmark: _Toc10032500]Activity: Create
Create a new workbook as shown below and save as COMPUTER.
Table 23: Computer data
	
	A
	B
	C
	D

	1
	COMPUTER ROOM S1.29
	COSTS
	
	

	2
	
	
	
	

	3
	ITEM
	UNIT COST
	NO OF UNITS
	TOTAL

	4
	
	
	
	

	5
	Systems Unit
	1500.00
	12
	

	6
	Monitor
	300.00
	12
	

	7
	Keyboard
	175.00
	12
	

	8
	Desk
	120.00
	12
	

	9
	Chairs
	99.00
	12
	

	10
	Printers
	620.00
	2
	

	11
	Filing Cabinet
	130.00
	1
	

	12
	Smartboard
	800.00
	1
	

	13
	TV Monitor
	410.50
	1
	

	14
	
	
	TOTAL COST
	


Format the worksheet:
Fields should be wide enough to display all data.
Set to currency, use bold and italics where appropriate.
Centre over worksheet and insert a border, pattern or colour to the main heading.
Calculate the total of each item (Unit Cost x No of Units).
Calculate the TOTAL COST of the equipment for the Computer Room.
Printers are currently on special for a UNIT COST of 550.00. Edit data.
Insert a column between ITEM and UNIT COST called LOCATION. Key in Room S1.29 and copy down for all items.
Key in Room S1.29 once, position mouse pointer in bottom right hand corner of box (autofill), hold down <CONTROL> and drag down to copy down.
Insert a row between Chairs and Printers and insert: 
(Item) Mouse and Mouse Mat (Unit Cost) 22.00 (No of Units) 12.
Delete a row—filing cabinets are no longer required.
Sort in ascending order according to ITEM.
Save.
Print the worksheet with your name in header and filename in footer.
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	Practice activity


[bookmark: _Toc10032501]Activity: 
Open: the workbook CROCS
1. Format the worksheet—columns should be wide enough to display information, all column headings should be centred and bold and all employee’s names should be in italics. 
Centre the heading ‘Manning River Crocodile Farm’ and ‘Wages for ...’ over the worksheet.
It was decided that medical insurance would now be paid by the company. Insert a column heading Medical between Income Tax and Super and enter the following details for each employee: 
Table 24: Medical Data
	Mayne, J
	40.00
	Downer, P
	35.00

	Skayse, C
	40.00
	Connell, R
	45.00

	Bond, E
	64.00
	Keates, S
	45.00

	Zapper, M
	74.00
	
	


Calculate each employee’s Super (Gross Wages * 20%).
Insert another column heading TOTAL DEDUCTIONS between SUPER and NET PAY and calculate the total of Income Tax, Medical and Super.
Calculate Net Pay (Gross Wage—Total Deductions).
C Skayse is no longer on the payroll so delete his record from the worksheet.
Insert a row label in A12 TOTAL and calculate the Gross Wage, Income Tax, Medical, Super, Total Deductions and Net Pay.
Insert a row label underneath Total called MAXIMUM and using the MAX function, determine the highest Gross Wage and Net Pay.
Insert two more row labels underneath Maximum called MINIMUM and AVERAGE and determine the lowest Gross Wage and Net Pay and the average Gross Wage and Net Pay.
Sort the worksheet in ascending order according to employee
Apply borders, colour, patterns and currency where appropriate
Insert your name in a footer
Save the workbook and preview before printing
[bookmark: _Toc10032502]Display/hide formula 
Click on Formulas Ribbon and Click on Show Formulas.
OR:
CTRL + ~
	ie, hold down CTRL while pressing the tilde ~ (top left key on keyboard).
Pressing CTRL + ~ a second time will hide the formulas.
[bookmark: _Toc10032503]Print worksheet to fit on one page
From the Page Layout Ribbon click on Page Setup, Page.
On the Scale to fit tab select 1 page for width and height.


[bookmark: _Toc10032504]Print selected range
Highlight the cells to be printed.
From the File Tab, click PRINT, then Settings.
Select Print Selection.
[image: ]
[bookmark: _Toc10032505]Percentages
To calculate 25% sales tax (Cell reference x percentage) =G3*25%
Projected sales: 15% increase =F5+F5*15% or =F5*115%.
Projected sales: 30% decrease =B8-B8*30% or =B8*70%.
To calculate 10% commission =A2*10% (Cell reference x percentage) 
Table 20 Detail on calculating 10%
	 
	A 
	B 

	1 
	Sales 
	Commission 

	2 
	$120 
	=A2*10% 
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	Practice activity


[bookmark: _Toc10032506]Activity: Calculations
Open: the workbook RETAIL 
Click on the SURFIN worksheet.
Calculate Total Sales and then calculate 10% Commission.
Format worksheet appropriately.
Complete the Summary at the bottom of the worksheet for each salesperson.
Add your name and filename in footer.
Print the worksheet to one page, and then print showing formulas.
Hide formulas and print only the information in the Summary (ie print the selection).
Resave and close the workbook.
Open: the workbook PERCENTAGES
Click on the PRICES worksheet.
Adjust column widths to display all data.
Calculate 5%, 10% and 20% for each item (% of the amount only).
Insert a column heading 7.5% Discount between 5% and 10%. Calculate 7.5% for each item.
Sort in order of ITEM
Insert a new item Grout, in order (Base Price of $12.90).
Calculate discount amounts and use auto-fill to move the formula to each item.
Insert a heading DISCOUNT PRICES centred over worksheet in 18pt font.
Insert a blank row between the heading and worksheet.
Format the figures as currency with 2 decimal places and display attractively.


Click on the COUNTRY worksheet.
1. Insert a column heading TOTAL SALES and calculate the Total Sales of goods sold for month (Selling Price x Quantity Sold).
Insert a new column heading called TOTAL COSTS between QUANTITY SOLD and TOTAL SALES and calculate (Cost Price x Quantity Sold).
Insert a column heading called TOTAL GROSS PROFIT and calculate the Total Gross Profit for the month (Total Sales—Total Cost).
Insert a new column label PROJECTED SALES—the premises are being renovated and total sales are expected to increase by 10%, insert a formula to determine future sales (add to total sales).
Insert a row label TOTAL at bottom of worksheet and calculate Quantity Sold, Total Costs, Total Sales, Total Gross Profit, Projected Sales.
Wrap column headings in cell, vertically centred, using borders, colour and shading.
Format to currency where appropriate, print in landscape, vertically centred on page and displaying your name and filename. Print formulas also, on one page.
Resave and close the Percentages workbook.



Topic 4
Produce simple 
charts
[bookmark: _Toc10032507]
Topic 4: Produce simple charts
[bookmark: _Toc10032508]Create a chart
1. Create the following worksheet
Table 21 Chart data
Gr8 Discounts – Recruitment Figures – January to April
	Store
	January
	February
	March
	April

	Sydney
	23
	24
	27
	25

	Melbourne
	17
	18
	20
	21

	Brisbane
	28
	30
	32
	26


Select/highlight the cells to be charted—A2:E5 (include row and column headings but not main heading or blank rows).
Press the [F11] function key (this inserts the chart on a separate sheet—Chart1).
To add Chart elements click on the Plus symbol next to the chart, then click the required check box.
[image: ]
Figure 21 - Chart elements
You should always include a meaningful Chart Title and Axis Titles and a Legend for Column, Bar or Line Charts. Pie Charts should include a meaningful Chart Title and Data Labels so it is easy to read on both a black and white or colour printout.
You can also create a Chart by going to Insert Ribbon, Charts group. The Recommended Charts options shows the charts which will best display the data you have selected or you can select the All Charts option.  Select the style of chart eg Column, Pie, Bar, Line.
[image: ]
The Chart will be then be inserted on the worksheet with your data.  It can be moved or resized on the worksheet.
Click on the Chart displayed to enable the Chart Tools Ribbon.
To change chart type—click on Design Tab in the Chart Tools Ribbon; Select Change Chart Type eg Column, Pie, Bar, Line.
To change the chart style—click on the Design Tab in the Chart Tools Ribbon, click on the down arrow in the Chart Styles group and select a style. 
To move the chart—click on Design Tab in the Chart Tools Ribbon, select Move Chart to choose between making your chart a separate sheet or making it appear as an object on your worksheet.
To select non-adjacent cells, select/highlight the required column and heading, then hold the Ctrl key and select/highlight the other required column and heading. Release the keys, then follow the procedures above to create your chart.
	[image: ]
	Practice activity


[bookmark: _Toc10032509]Activity: Percentages
Open: the Workbook Percentages—Country worksheet 
1. Select Item and Cost Price information, including column headings, and press [F11] to create a column chart on a separate sheet.
Add the chart title COST PRICE.
Add data labels, outside end.
Add your name as a footer and print.
Change the chart type to a Pie chart.
Add data labels.
Add your name as a footer and print.
[bookmark: _Toc10032510]Absolute and relative cell references
[bookmark: _Toc10032511]Relative References
When a formula is copied to another cell, the formula is automatically updated to the new location e.g. it adjusts as it is copied down: C1, C2, C3 etc.
[bookmark: _Toc10032512]Absolute References 
If you want the cell reference to stay fixed, it can be created as an absolute cell reference. Microsoft uses a code to indicate the absolute reference and uses the dollar sign ($) in front of the row or column label or both. This does NOT mean it is currency.
Example: a cell reference $A$1 indicates that both the column and the row are absolute—that is the formula always refers back to the same cell. F6*$G$2 means that F6 is a relative reference, but G2 is the absolute, or fixed reference.
Formula can either be typed in, inserting the dollar signs manually or by pointing to the cell where reference is to be fixed and pressing <F4> (which automatically inserts the $ signs for both the Column and Row).


	[image: ]
	Practice activity


[bookmark: _Toc10032513]Activity: Data fines
1. Create the following workbook and save as FINES.
Calculate the amount owing by each person—use an Absolute Reference for the Daily Overdue Rate.
Print a copy showing the formulas.
Save and close the workbook.
Carnaby Library—Overdue books as at (Current Date)
Daily overdue rate = $2.00
Table 25: Data fines table
	Name
	Computer number
	Days overdue
	Amount owing

	Able
	1890
	4
	

	Cossetini
	4367
	1
	

	Campbell
	2143
	2
	

	Barnes
	1936
	3
	

	Beech
	2087
	1
	


1. Create the following workbook and save as SOUTHS.
Use an absolute reference when referring to the TAX RATE 10%.
Calculate Gross Pay, Tax and Net Pay.
Print a copy showing the formulas.
Save and close the workbook.


Southseas Pty Ltd—Payroll - August 2011
Table 26: Activity data payroll
	
	Hours worked
	Hourly Rate
	Gross Pay
	Tax

	Harry hook
	14
	22.00
	
	

	Peter pan
	22
	30.00
	
	

	Tom bell
	4
	11.00
	
	

	John silver
	6
	12.00
	
	

	
	
	
	
	

	Tax rate
	10%
	
	
	


Create the following workbook and save as CAR.
Use Autosum to determine the total sales of each car and Auto-fill down.
Note: how formula adjusts relative to its location.
Calculate the Grand Total in cell F11.
To calculate the percentage of the total sales, your formula will need to make absolute reference to the Grand Total. You want to find out what percentage of sales each model of car represents. ie what percentage of Sedans were sold overall?
Insert formula as indicated in % OF TOTAL SALES column and auto-fill down. Note relative cell reference adjusts but the absolute cell reference does not.
Show your teacher the formulas.
Save and close the workbook.


Getupngo car sales—Sales for the Hunter: May 2012
Table 27: Activity data car sales
	Model
	City
	Belmont
	Glendale
	Cessnock
	Total
	% of total sales

	Sedan
	25
	30
	19
	33
	=SUM(B5:E5)
	=F5/$F$11

	Wagon
	12
	15
	18
	10
	=SUM(B6:E6)
	=F6/$F$11

	Coupe
	6
	8
	12
	8
	=SUM(B7:E7)
	=F7/$F$11

	Utility
	7
	4
	9
	12
	=SUM(B8:E8)
	=F8/$F$11

	Hatchback
	11
	7
	12
	9
	=SUM(B9:E9)
	=F9/$F$11

	
	
	
	
	
	
	

	
	
	
	
	Grand total
	= sum(F5:F9)
	


F11 will be the Absolute Cell Reference (highlighted cell)



Topic 5
Finalise and 
present 
spreadsheets


[bookmark: _Toc10032514]Topic 5: Finalise and present spreadsheets
[bookmark: _Toc10032515]Style guides
A style guide is a set of editing and formatting standards for use by staff in a specified organisation.
Style guides help individuals and departments to prepare company documents consistent with the Company’s corporate style. The Style Guide explains the style to be applied to company documents together with information on typography, and advice for writing and producing documents. If you are using plan2go as your virtual organisation, you will use their style guide to complete your assessments. Find it here: Plan2go style guide.
[bookmark: _Toc10032516]Using a style guide 
Your spreadsheet needs to meet the requirements of Spreadsheet Solutions and display a professional and consistent approach for all documents.
The information needs to be presented in a clear, easy to read and understand format.
All spreadsheets produced at Spreadsheet Solutions must follow a professional design and appearance to meet the requirements of the business.
Using templates
In the Spreadsheet Solutions Intranet under Documentation, you will find templates that meet the requirements set out in this style guide. 
These include: 
Balance sheet template.
Expenses claim form.
General Information Spreadsheet.
Profit and Loss Statement Template.
To use any of these spreadsheets you will need to download the template and save it to your computer.
You must not add or delete sections, rows or columns of any of the template spreadsheets unless you have approval from your manager.


When you don’t have templates
When formulating spreadsheets that don’t have templates already created—you need to follow these guidelines to ensure consistency across the organisation:
Font for all text and data is to be Calibri.
Font size for normal text and data is to be 11pt.
Font size for column headings is to be 11pt bold.
Font size for the main spreadsheet heading is to be 18pt bold, merged and centred.
Headers and Footers
Headers to include:
Filename using automatic codes.
Footers to include:
Author on left hand side.
Date using automatic code on right hand side.
Printing
Use A4, Portrait or Landscape dependent on size of the worksheet.
Centre Worksheet horizontally and vertically on the page.
All data must fit be scaled to fit on one page.
Print gridlines for all worksheets.
Number formats
All dollar figures must have dollar sign, unless the symbol ‘$’ is displayed in the corresponding column header.
Totals and important result figures to be highlighted using shading and bold.
Design points.
Resize column widths to fit all text and data.


Format and review
Complete a full spell check on the finished document and correct any spelling errors.
Check all formulas using the “Show Formula” function and correct errors as required.
Complete a “Print Preview” on the finished document as a final check.
Please seek advice from your work colleagues, supervisor or manager if you are unsure of these requirements.
	[image: ]
	Practice activity


[bookmark: _Toc10032517]Activity: Style guides
Use either Plan2go or the Sample STYLE GUIDE for this task, check with your teacher.
[bookmark: _Toc10032518]Revision workbook
Open the Workbook REVISION.
Click on FIXIT QUICK tab.
1. Insert a new column between Employee and Rate of Pay called HOURS WORKED and enter the following numbers/values:
HOBAN, B		40
LEWIS, G		37
WILSON, W	35
SMITH, B		40
NEAL, Q		37
MASON, R		35
Calculate GROSS PAY (Hours Worked X Rate of Pay).
Insert a new column in Column E called TAX and calculate (Gross Pay * 25%).
Insert a new column in Column F called NET PAY and calculate (Gross Pay—Tax).
All employees have decided to pay superannuation—insert a new column between Gross Pay and Tax called SUPER. Calculate superannuation (Gross Pay * 10%).
Update Net Pay—edit formula to include full range of deductions.
Enter a new row label in Column A under employee’s names (leave one blank row) called TOTAL WAGES. Calculate and insert total of NET PAY (Column G—use SUM function).
Add another row under TOTAL WAGES called AVERAGE RATE and calculate average Rate of Pay.
	Sort employees in descending order.
	Insert a new employee in order: PRATT, Katy Hours Worked (37) Rate of Pay ($12.60).
	Use Autofill to calculate Katy’s GROSS PAY, SUPER, TAX and NET PAY (start from original formula at top and copy down over existing numbers/values) 12. Quentin Neal has left the company—delete him from the payroll.
	Format the worksheet as per the style guide.
Insert a heading at top of worksheet FIXIT QUICK COMPANY and format as per the style guide.
Insert a new row underneath the heading. Use =TODAY() function to insert date.
Insert a blank row between the date and column labels.
Wendy Wilson has been attending a TAFE course—her hourly rate has been increased to $13.50—edit data.
Create a header and footer as per the style guide.
Format and review as per the style guide.
	Save changes to worksheet. Print two copies—one with answers and one with formulae showing in landscape as per style guide requirements for printing.
	Create a bar chart which displays the Workers’ names and their Net pays. Add meaningful chart title, axis titles and data labels showing values. Add your name in the footer, then print.
	Change the chart type and create a pie chart. Include data labels, outside the chart, showing values and the category name. Add your name in the footer then print.


[bookmark: _Toc10032519]Vinos tab
Open the Workbook REVISION.
Click on VINOS tab.
1. Calculate the GROSS PAY and Tax (Gross Pay * 25%) for all employees.
Insert a new column called OVERTIME between HOURS WORKED and GROSS PAY and insert overtime hours as follows: 
Wine, S 		(4)
Scotch, D 		(6)
Liquid, A 		(5)
Vino, B 		(9)
Daniels, J 		(7)
Edit GROSS PAY to include overtime which is paid at twice the normal rate of pay ie RATE OF PAY * HOURS WORKED + OVERTIME * RATE OF PAY * 2. Copy down formula to update.
Calculate amount for Net Pay and copy down.
	Sort in ascending order of NAMES.
Bianca Vino’s brother Tony has joined the company—insert in order: Rate of Pay (13.50) Hours Worked (37) Overtime (1). Update Tony’s details by copying formula down again.
Insert a new row label TOTAL WAGES at A9 (wrap text and vertically align in cell).
Calculate total of GROSS PAY in B9 using range from Gross Pay.
Insert a new row label AVERAGE at A10 and calculate the average Gross Pay (using Gross Pay data) in cell B10.
	Add a main heading at the top of the worksheet VINO’S ESTATE.
	Insert another row underneath the heading and insert the date =TODAY().
	Insert a blank row between the date and the rest of the worksheet.
	Edit Amber Liquid’s hours worked as she only worked 22 hours.
	Check your worksheet reflects the style guide requirements.
	Print a copy in landscape showing answers and a copy showing formulas.
	Graph the Name and Hours Worked into a separate 3-D column chart. Add data labels to the columns showing values. Add a meaningful chart title, axis titles and your name in the footer, then print. 
Change the chart type and create a pie chart. Add data labels inside the chart, showing values and the category name. Add your name in the footer, then print. 
[bookmark: _Toc10032520]Workers tab
Open the Workbook REVISION.
Click on the WORKERS tab.
This payroll has been prepared for the WORKERS ‘R US employees.
1. Insert a new column between Hourly Rate and Weekly Wage called Hours Worked and enter the following hours for each worker: 
Dillon 	(37)
Brendon 	(39)
Kelly 	(35)
Andria 	(37)
David 	(39)
Steve 	(40)
Donna 	(38)
Calculate the WEEKLY WAGE and copy down.
Insert a new column after Weekly Wage called TAX. Calculate Tax payable (Weekly Wage * 25%).
Insert a new column after Tax called NET WAGE. Calculate Net Wage.
Sort the worksheet in ascending order of Surname.
Insert a new row label TOTAL leaving a blank row between it and workers. Calculate total amount of Weekly Wage, Tax and Net Wage.
Insert a new row label underneath Total called AVERAGE and calculate average hourly rate and hours worked.
Insert a heading WORKERS ‘R US at the top of the worksheet. Insert a blank row between the heading and the worksheet.
There have been some changes, amend as follows:
Brendon Walsh has left—delete his record.
Melissa Nevins has joined the company, insert her details in correct order—she worked 15 hours this week at an hourly rate of $16.70—ensure you check your formula and/or range to see if all workers are included in totals etc.
Donna Martin’s hourly rate has increased to $15.30—amend her record
	Save the worksheet under a new name WORKERS1—double click WORKERS tab at bottom of workbook and type new name in dialog box.
	Format/check the worksheet in accordance with the style guide requirements.
	Print a copy of your worksheet in landscape and print a copy showing formulas.
	Create a column chart as a separate sheet showing Workers and their Hourly Rates. Add a meaningful chart title, axis titles and data labels showing values to the columns. Print a copy.
	Change the chart type and create a pie chart. Add data labels, outside the chart, showing values. Print.
[bookmark: _Toc10032521]Flowers workbook
1. Create following workbook and save it as FLOWERS.
Table 28: Activity data Flowers
	Say It With Flowers 
	

	Flower Sales 
	

	ITEM 
	NO SOLD 

	Bouquet (6 roses) 
	380 

	1 dozen roses 
	406 

	1 long-stemmed rose 
	285 

	Rose and carnation basket 
	190 

	Native bowl arrangement 
	240 

	Table arrangement 
	160 

	Terracotta pot arrangement 
	200 


Create a column chart to show flower sales as a separate sheet. Add axis titles and data labels with values to the columns.
Change the title of the chart to FLOWER SALES CURRENT YEAR. Print the chart with your name as a footer.
On the worksheet, insert a column between ITEM and NO SOLD, called PRICE and enter the prices shown below:
Table 29: Activity data price
	ITEM 
	PRICE 
	NO SOLD 

	Bouquet (6 roses) 
	35 
	380 

	1 dozen roses 
	65 
	406 

	1 long-stemmed rose 
	20 
	285 

	Rose and carnation basket 
	65 
	190 

	Native bowl arrangement 
	65 
	240 

	Table arrangement 
	40 
	160 

	Terracotta pot arrangement 
	40 
	200 


Insert two more columns to the left of column C, as follows: 
Table 30: Activity data extra columns
	ITEM 
	PRICE 
	LESS DISCOUNT 
	SELLING PRICE 
	NO SOLD 

	Bouquet (6 roses) 
	35 
	
	
	380 

	1 dozen roses 
	65 
	
	
	406 

	1 long-stemmed rose 
	20 
	
	
	285 

	Rose and carnation basket 
	65 
	
	
	190 

	Native bowl arrangement 
	65 
	
	
	240 

	Table arrangement 
	40 
	
	
	160 

	Terracotta pot arrangement 
	40 
	
	
	200 


Insert formula in Cell C5 to calculate the discount amount—it is 5% of the Price. Fill down to calculate discount on all flower prices.
To calculate the selling price, enter a formula in D5, subtracting the discount amount from the Price. Fill down.
Enter a new column heading in F4: TOTAL.
In F5, enter a formula to multiply the number of items sold by the selling price. Fill down.
In A13, enter the heading: TOTAL SALES.
Enter a formula in E13 and F13 to calculate both the total number sold and the total sales amount.
In cell A14, enter the heading: AVERAGE SALES and enter a formula in F14 to calculate the average figure in the cell range F5:F11.
Sort the spreadsheet so that the least expensive item is at the beginning of the list.
Format/check the worksheet in accordance with the style guide requirements.
Print the worksheet, and then print the formulas and make sure that it fits on one page.


[bookmark: _Toc10032522]Summary
You have successfully completed this resource. Great work! You should be able to create spreadsheets and charts using the essential features of MS Excel. All the best for success in your assessments!
[bookmark: _Toc10032523]Attributions table
	Image 
	Attribution

	All screenshots
	Created by TAFE NSW and used with permission from Microsoft
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